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Introduction 

Welcome to the Excel Review and Quick Reference Guide.  This course is NOT an introductory 

course.  Instead, it is a review course.  It is for the many users of Excel who are self-taught, and who 

wonder if there are basic Excel concepts, that they never learned, that could save them hours of 

work. 

What this guide is not 

Unlike many books on Excel, this guide does NOT provide detailed explanations.  Instead, its 

purpose is to be a mere Quick Reference guide.  This allows readers to quickly review HOW to do 

something without wading through explanations about the WHAT and the WHY.  For example, this 

guide shows you how to create a PivotTable, but only provides one short sentence about what a 

PivotTable is and what it can do for you.  If you are looking for a more details, please check out 

TechMentors other courses. 
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Course Outline 
Upon completion of this course, students will be able to: 
 

Navigate and format worksheets 
• Use over 60 keyboard shortcuts to navigate and/or 

manipulate an Excel workbook 

• Change the font, alignment, and number format of 
data using the standard formatting icons 

• Insert rows and columns 

• Delete rows and columns 

• Freeze data rows at the top of the screen 

• Freeze data column at the left edge of the screen 

Manipulate Excel data 
• Use the AutoFill feature to quickly fill in lists of 

values, month names, names of the days of the 
week, date values, and number patterns 

• Filter data to display a data subset 

• Sort data by one or more columns 

Prepare data for printing 
• Select a specific area for printing 

• Fit a printout on one horizontal and/or vertical page  

• Add a page header and/or footer 

• Print column headers at the top of each page 

Design an Excel PivotTable 
• Define what a PivotTable is and describe its use 

• List the data rules that must be follow before a 
PivotTable can be created  

• Create a PivotTable 

 

Create advanced formulas 
• List the four range operators and describe how they 

can be used in an Excel formula 

• Use the five mathematical operators in a numeric 
formula 

• List the five logical operators and describe how 
they can be used in a comparison formula 

• Save time and prevent calculation errors by 
properly using the proper absolute, mixed, and 
relative reference operators in a formula 

• Increase / decrease the size of the Excel formula 
bar 

• Employ techniques for creating complex mega 
formulas 

Use the following functions 
Summary  

• Sum 

• Average 

• Count 

• Min 

• Max 

• Small 

• Large 

• Median 

• Mode 

• SumIf 

• CountIf 

• SumIfs 

• CountIfs 

Lookup 
• VLookup 

• HLookup 

• Index 

• Match 

Logical 
• If 

• And 

• Or 

• Not 

• IfError 
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Keyboard Shortcuts 

Selecting 

One cell to the right → 

One cell to the left   

One cell down  or Enter 

One cell up  or Shift + Enter 

One screen down Page Down 

One screen up Page Up 

Beginning of sheet (A1) Ctrl + Home 

End of sheet (last cell) Ctrl + End 

To the end of contiguous data Ctrl + Arrow or  
End + Arrow 

A cell or range of cells Ctrl G or F5  
then enter 
address 

Next sheet Ctrl + Page Down 

Previous sheet Ctrl + Page Up 

Whole column Ctrl + Space Bar 

Whole row Shift + Space Bar 

One more cell to the right Shift + → 

One more cell to the left Shift +  

One more cell up Shift +  

One more cell down Shift +  

All the contiguous data to the right Ctrl + Shift + → 

All the contiguous data to the left Ctrl + Shift +  

All the contiguous data up Ctrl + Shift +  

All the contiguous data down Ctrl + Shift +  

All cells Ctrl A 

All contiguous cells Ctrl + * 

 

File Functions 
Open file Ctrl + O 
Save file Ctrl + S 
Close window Ctrl + W 
New file Ctrl + N 
Print file Ctrl + P 

 

Formatting 
Format cells Ctrl + 1 
Bold Ctrl + B 
Italic Ctrl + I 
Underline Ctrl + U 

 

 

Function Keys 

Help F1 

Instant Chart same sheet Alt + F1 

Edit cell formula F2 

Paste Name box F3 

Insert function Shift + F3 

Toggle absolute / 
relative references 

F4 

Go to specified cell F5 

Go to next pane F6 

Check spelling F7 

Toggle extended mode F8 

Recalculate F9 

Activate ribbon options 
with letters 

F10 

Instant Chart new sheet F11 

Save As F12 

Editing 

Cut Ctrl + X 

Copy Ctrl + C 

Paste Ctrl + V 

Undo Ctrl + Z 

Redo Ctrl Y 

Insert cells, rows, or 
columns 

Ctrl + + 

Delete cells, rows, or 
columns 

Ctrl + - 

Find Ctrl + F 

Search and Replace Ctrl + H 

Erase cell contents Delete 

Finish cell formula and 
stay in cell 

Ctrl + Enter 

Cancel edit Esc 

Insert new line in cell Alt + Enter 

Insert current date Ctrl + ; 

Insert current time Ctrl + : 

Toggle display between 
formulas vs. values 

Ctrl + ` 
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Formatting Options 

Format Cells 

 
Figure 1: Home tab, Font group 

 
Font 

 
Borders 

 
Font Size 

 
Background color 

 
Increase Font 

 
Font color 

 Decrease Font  More font settings 

 Bold   

 Italic   

 Underline   

 

 
Figure 2: Home tab, Alignment group 

 
Align Top 

 
Rotate Text 

 
Align Middle   Decrease Indent 

 
Align Bottom  Increase Indent 

 Align Left  Wrap Text 

 Align Center  Merge & Center 

 
 

Align Right 
 

More alignment  
settings 

 

Format numbers 

 
Figure 3: Home tab, Number group 

Drop down options 

 

Buttons 

 Currency $      1,234.57 

 Percentage 12% 

 Comma 1,234.57 

 Increase decimals 

 Decrease decimals 

 More number format options 
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Insert Rows / Columns 
Position the cursor in the desired location and right click and choose Insert… or press Ctrl + +.   
Then choose the desired option from the pop-up menu. 

 
 

Delete Rows / Columns 
Position the cursor in the desired location and right click and choose Delete… or press Ctrl + -.   
Then choose the desired option from the pop-up menu. 

 



Excel Quick Reference Guide Guide  Page 12 

TechMentors Computer Training & Consulting Services     www.TheTechMentors.com     435.213.1622 
© Copyright 2025 All rights reserved 

Freeze Panes 
From the ribbon’s View tab you can Freeze Panes to “freeze” headings (rows at the top and/or 
columns at the left) so they don’t disappear as you scroll through the spreadsheet. 

If you need to freeze both rows and columns, first position the cursor in the cell just below and to 
the right of the rows and columns you want frozen.  For example, if you want to freeze rows 1 
through 4 and columns A through C, you would position your cursor in cell D5, and then choose 
View, Freeze Panes, Freeze Panes. 
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Auto Fill 
Enter a name from a series (like the name of a month), or a formula, or one or more values.   
Then drag or double click the AutoFill button (the cell’s bottom right corner) as needed. 

 
 

 
 

 

Instant Charts 
You can quickly create a chart by selecting your data and then pressing Alt F1 or F11.   
Alt F1 creates a chart on the same sheet, while F11 creates a chart on a new sheet. 

 

You can then change the chart from the ribbon’s Chart Design tab, Change Chart Type button. 
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Filter data 
From the ribbon choose Data, Filter.   

 

Then click the column heading’s drop down to apply the desired filter. 
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Sort data 
To sort your data, click on one cell, that has data, in the column you want sorted.   
Then from the ribbon Data tab click one of the three sort buttons. 

 

 

Sort lowest to highest 

 

Sort highest to lowest 

 

Custom sort – lets you do a multi-column sort. 
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Printing 

Select a print area 
Select desired range of cells, then from the Page Layout tab choose Set Print Area as shown below. 

 

Fit print to one page wide 
From the Page Layout tab choose 1 page for the width as shown below. 

 

Fit print to one page tall 
From the Page Layout tab choose 1 page for the height as shown below. 

 

Add header / footer 
From the Insert tab choose Header & Footer then type your text in the desired location. 
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Print rows at top of each page 
From the Page Layout tab click Print Titles, then select the rows to repeat at top and click OK. 
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PivotTables 
PivotTables allow you to arrange and summarize complex data in an easy to read report that is easy 
to manipulate.  To create a simple PivotTable follow these steps: 

1. Start Excel and create or open your file. 

2. Make sure your data can support a PivotTable by using the check list below: 

 Each column of data has a column heading 

 Each column heading is unique 

 Each column heading is in the same row 

 The column headings do not span multiple rows 

 No merged cells exist 

 All the data is contiguous 

 The data in each column follows a consistent format 

3. Position the cursor in one cell, and only one cell of the data. 

 

4. From the ribbon choose Insert, PivotTable. 

 

5. In the resulting dialog box make sure the table/range is referring to the correct table or range 
and that the destination is a New Worksheet, then click OK. 
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6. Drag the fields from the PivotTable Field List to the desired location as shown below. 

 

You now have a PivotTable. 
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Range Operators 

Cell address 
with no 
operator 

Refers to cell address B2 

 

: Refers to all cells between first 
and last reference 

A1:C3 

 

, Refers to first and last reference A1,C3 

 

! Refers to address on the specified 
sheet 

Sheet2!B2 

 

$ Designates that a column or row 
reference is absolute and 
therefore cannot change when 
copied. 

=$A$1 + 1 

 

Formula Operators 
Every formula must begin with an equal, plus, or minus sign.  If parentheses ( ) are used, expressions inside the 
parentheses are processed before expressions outside the parentheses. 

+ Add = 20 + 2 22 

- Subtract = 20 – 2  18 

* Multiply = 20 * 2  40 

/ Divide = 20 / 2  10 

^ Exponent = 20 ^ 2 400 

& Concatenate = 20 & 2 202 
 

= Equals = 20 = 10  FALSE 

> Greater than = 20 > 10  TRUE 

>= Greater than 
or equal to 

= 20 >= 10 TRUE 

< Less than = 20 < 10  FALSE 

<= Less than or  
equal to 

= 20 <= 10  FALSE 
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Order of Operations 
Excel follows the standard PEMDAS order of operations.  This means expressions are performed in 
the following order: 

1 P Parenthesis ( ) 

2 E Exponents ^ 

3 MD Multiplication and Division * / 

4 AS Addition and Subtraction + - 

Formulas vs. Functions 
Formulas and functions are not the same thing.  A simple formula is an equation that involves use of 
operators like + - * / and &.  A function is a predefined programmed calculation that has a name, a 
set of parentheses, and usually has one or more parameters.  Complex formulas often combine one 
or more simple formulas and/or one or more functions. 
 

Sample Formulas 

Addition = A1 + B1 = A1 + 3 

Subtraction = A1 – B1 = A1 – 3 

Multiply = A1 * B1 = A1 * 3 

Divide = A1 / B1 = A1 / 3 

Concatenation = A1 & B1 = “John ” 
& “Adams” 

 

Sample Functions 

Sum =Sum(A1:A10) Totals values in A1 through A10. 

Average =Average(A1:A10) Calculates the average of the 
values in A1 through A10. 

Count =Count(A1:A10) Counts the cells with numeric 
data in A1 through A10. 

CountA =CountA(A1:A10) Counts the cells with alpha or 
numeric data in A1 through A10. 

 

Sample Complex Formula 
= “Your half of the total is “ & ( SUM(A1:A10) / 2 ) & “.” 

Expand the formula bar 
When you have a long formula you might want an expanded formula bar so you can see the whole 
thing.  Just click the expand button shown below.  After that you can drag the border with the 
mouse to make it even bigger. 
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Absolute, Mixed, and Relative References 
When a formula is copied from one cell to another, you have four options for how the formula’s cell 
addresses will be adjusted relative to the new vs. original location.  You select the options you want 
by choosing whether or not to place a $ in front of the row number and/or column letter. 
 

Absolute Reference – nothing changes 
Use a $ in front of both the column letter and 
row number 

 

No matter where the destination cell is, the row 
number and the column letter will not change. 

In this example, when B2 is copied down to a 
cell in row 3, the “1” stays a “1” because the $ 
in front of the row letter makes it absolute. 

When B2 is copied across to a cell in column C, 
the column letter remains an “A” because the 
proceeding $ makes it absolute. 

Relative Row, Absolute Column 
Use a $ in front of the column letter but not the 
row number 

 

Based on the destination cell, the row number 
can change but the column letter will not 
change. 

In this example, when B2 is copied down to a 
cell in row 3, the “1” becomes a “2”.  

When B2 is copied across to a cell in column C, 
the column letter remains an “A” because the 
preceding $ makes it absolute. 

Absolute Row, Relative Column 
Use a $ in front of the row number but not the 
column letter. 

 

Based on the destination cell, the row number 
will not change but the column letter can 
change. 

In this example, when B2 is copied down to a 
cell in row 3, the “1” remains a “1” because the 
$ in front of the row letter makes it absolute. 

When B2 is copied across to a cell in column C, 
the column letter changes to a “B”. 

Relative Reference 
Do not place a $ in front of the row number 
and do not place a $ before the column letter. 

 

Based on the destination cell, both the row 
number and the column letter can change. 

In this example, when B2 is copied down to a 
cell in row 3, the “1” becomes a “2”.  

When B2 is copied across to a cell in column C, 
the column letter changes to a “B”. 
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Summary Functions 

Sum 

Description Adds all the numbers you specify 

Syntax SUM(Number1, [Number2]…) 

Arguments Number1 Required The first number, cell, or range to be added 

Number2 Optional The next number, cell, or range to be added 

NumberN Optional You can have up 255 number arguments 

Example 

 

 

Average 

Description Returns the average value of a group of numbers 

Syntax Average(Number1, [Number2]…) 

Arguments Number1 Required The first number, cell, or range to be averaged 

Number2 Optional The next number, cell, or range to be averaged 

NumberN Optional You can have up 255 number arguments 

Example 
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Count 

Description Counts the number of cells that have a numeric value 

Syntax Count(Value1, [Value2]…) 

Arguments Value1 Required The first number, cell, or range to be counted 

Value2 Optional The next number, cell, or range to be counted 

ValueN Optional You can have up 255 number arguments 

Example 

 

 

CountA 

Description Counts the number of cells that have a non-blank value 

Syntax CountA(Value1, [Value2]…) 

Arguments Value1 Required The first number, cell, or range to be counted 

 
Value2 Optional The next number, cell, or range to be counted 

ValueN Optional You can have up 255 number arguments 

Example 
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Min 

Description Calculates the smallest of a group of values 

Syntax MIN(Number1, [Number2]…) 

Arguments Number1 Required The first number, cell, or range of cells 

Number2 Optional The next number, cell, or range of cells 

NumberN Optional You can have up 255 number arguments 

Example 

 

 

Max 

Description Calculates the largest value of a group of values 

Syntax MAX(Number1, [Number2]…) 

Arguments Number1 Required The first number, cell, or range of cells 

Number2 Optional The next number, cell, or range of cells 

NumberN Optional You can have up 255 number arguments 

Example 
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Small 

Description Calculates the Kth smallest value of a group of values 

Syntax SMALL(Array, K) 

Arguments Array Required The numbers or cells that have the data 

K Required The position within the array.  If K is 2 the function 
returns the 2nd smallest value. 

Example 

 

 

Large 

Description Calculates the Kth biggest value of a group of values 

Syntax LARGE(Array, K) 

Arguments Array Required The numbers or cells that have the data 

K Required The position within the array.  If K is 2 the function 
returns the 2nd biggest value. 

Example 
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Median 

Description Calculates the number that is in the middle of a set of numbers 

Syntax MEDIAN(Number1, [Number2]…) 

Arguments Number1 Required The first number, cell, or range of cells 

Number2 Optional The next number, cell, or range of cells 

NumberN Optional You can have up 255 number arguments 

Example 

 

 

Mode 

Description Calculates the number that occurs most frequently in a set of numbers 

Syntax MODE(Number1, [Number2]…) 

Arguments Number1 Required The first number, cell, or range of cells 

Number2 Optional The next number, cell, or range of cells 

NumberN Optional You can have up 255 number arguments 

Example 
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SumIf 

Description Sums the number of cells in a range that match a given criteria 

Syntax SUMIF(Range, Criteria, [Sum_range]) 

Arguments Range Required The set of cells to test 

Criteria Required The condition the cells must match in order to 
be added 

Sum_range Optional The cells that are to be added.  If left blank the 
cells in the range parameter are used. 

Example 

 

 

CountIf 

Description Counts the number of cells in a range that match a given criteria 

Syntax COUNTIF(Range, Criteria) 

Arguments Range Required The set of cells to count 

Criteria Required The condition the cells must match in order to be 
counted 

Example 
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SumIfs 

Description Sums the number of cells in a range that match all the given criteria 

Syntax SUMIFS(Criteria_range1, Criteria1, [Criteria_range2],[Criteria2]…) 

Arguments Sum_range Required The cells that are to be added 

Criteria_range1 Required The first set of cells to be evaluated 

Criteria Required The criteria the first set must match 

Criteria_range2 Optional The second set of cells to be evaluated 

Criteria2 Optional The criteria the first set must match 

Notes The criteria can be literal text or cell references. 
Literal criteria should be placed inside quotes. 
Operators like =, >, <  can be used as part of the criteria 
Use ? and * as wildcards to represent one or multiple characters. 

Example 
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CountIfs 

Description Counts the number of records in a range that match all the given criteria 

Syntax COUNTIFS(Criteria_range1, Criteria1, [Criteria_range2],[Criteria2]…) 

Arguments Criteria_range1 Required The first set of cells to be evaluated 

Criteria Required The criteria the first set must match 

Criteria_range2 Optional The second set of cells to be evaluated 

Criteria2 Optional The criteria the first set must match 

Notes The criteria can be literal text or cell references. 
Literal criteria should be placed inside quotes. 
Operators like =, >, <  can be used as part of the criteria 
Use ? and * as wildcards to represent one or multiple characters. 

Example 
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Lookup functions 

VLookup 

Description Looks for a value in the first column of a table and then returns the value from 
the specified column of that same row 

Syntax VLOOKUP(Lookup_value, Table_array, Col_index_num, [Range_lookup]) 

Arguments Lookup_value Required The value to find 

Table_array Required The table or range of cells where the 
value can be found 

Col_index_num Required The column number in the table from 
which the value is to be returned 

Range_lookup Optional Leave blank or enter TRUE to find the 
closest match, enter FALSE to find 
only an exact match 

Notes If the Range_lookup is blank or TRUE then the data must be sorted in ascending 
order. 

Example 
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HLookup 

Description Looks for a value in the first row of a table and then returns the value from the 
specified row of that same column 

Syntax HLOOKUP(Lookup_value, Table_array, Row_index_num, [Range_lookup]) 

Arguments Lookup_value Required The value to find 

Table_array Required The table or range of cells where the 
value can be found 

Row_index_num Required The row number in the table from which 
the value is to be returned 

Range_lookup Optional Leave blank or enter TRUE to find the 
closest match, enter FALSE to find only 
an exact match 

Notes If the Range_lookup is blank or TRUE then the data must be sorted horizontally in 
ascending order. 

Example 
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XLookup 

Description Looks for a value in a column and then returns the value from the same row of a 
corresponding column 

Syntax XLOOKUP(Lookup_value, Lookup_array, Return_array, [If_not_found], 
[Match_mode], [Search_mode]) 

Arguments Lookup_value Required The value to find 

Lookup_array Required The column or range of cells where the value can 
be found 

Return_array Required The column or range of cells where the desired 
value can be found 

If_not_found Optional Value to display if the Lookup_value is not found 

Match_mode Optional 0 or blank for exact match 
-1 for exact match or next smaller item 
1 for exact match or next larger item 
2 for wildcard character match 

Search_mode Optional 1 or blank for search of first-to-last 
-1 for search of last-to-first 
2 for binary search (sorted in ascending order) 
-2 for binary search (sorted in descending order) 

Example 
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Logical functions 

If 

Description Evaluates a logical expression.  If the expression is true one value is returned, if 
not another value is returned. 

Syntax IF(Logical_test, [Value_if_true], [Value_if_false]) 

Arguments Logical_ 
test 

Required The expression that is either TRUE or FALSE 

Value_if_true Optional The value you want returned if the logical 
expression is TRUE 

Value_if_false Optional The value you want returned if the logical 
expression is FALSE 

Example 

 

 

And 

Description Determines if all the arguments are TRUE 

Syntax AND(Logical1, [Logical2]) 

Arguments Logical1 Required Expression that results in either TRUE or FALSE 

Logical2 Optional Expression that results in either TRUE or FALSE 

LogicalN Optional Expression that results in either TRUE or FALSE 
You can have up 255 logical expressions. 

Example 
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Or 

Description Determines if any of the arguments are TRUE 

Syntax OR(Logical1, [Logical2]) 

Arguments Logical1 Required Expression that results in either TRUE or FALSE 

Logical2 Optional Expression that results in either TRUE or FALSE 

LogicalN Optional Expression that results in either TRUE or FALSE 
You can have up 255 logical expressions. 

Example 

 

 

Not 

Description Changes FALSE to TRUE and TRUE to FALSE 

Syntax NOT(Logical) 

Arguments Logical Required Expression that results in either TRUE or FALSE 

Example 
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Advanced functions 

Index 

Description Determines the value from a table or range of cells that is at the intersection of 
the specified row number and column number. 

Syntax INDEX(Array, Row_num, [Column_num]) 

Arguments Array Required The table or range of cells 

Row_num Required Specifies the desired row number, relative 
to the range of cells. 

Column_num Optional Specifies the desired column number, 
relative to the range of cells. 

Example 
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Match 

Description Calculates the position of a value in a range of cells 

Syntax MATCH(Lookup_value, Lookup_array, [match_type]) 

Arguments Lookup_value Required The value you want to find 

Lookup_array Required The range of cells that will contain the 
lookup_value 

Match_type Optional Leave blank or enter 1 to find the closest 
value without going over.  The data must 
be sorted in ascending order. 
Enter 0 to find an exact match. 
Enter -1 to find the closest value without 
going under.  The data must be in 
descending order. 

Example 
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Complex formula using Index and Match 

Description You can use Index and Match to find data in one column based on the location 
of a value in another column. 

Syntax INDEX(Array,  
MATCH(Lookup_value, Lookup_array, [match_type]),  
Column_num) 

Example 

 

 

IfError 

Description If a value results in an error, displays an alternate value instead. 

Syntax IFERROR(Value, Value_if_error) 

Arguments Value Required The value you want to display, unless it 
results in an error. 

Value_if_error Required The alternate value to use instead. 

Example 
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